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Leaf Cell Layout ConsiderationsLeaf Cell Layout Considerations

For very wide transistors For very wide transistors 
–– layout a number of parallel transistorslayout a number of parallel transistors

•• Instance an vector of transistors in the Instance an vector of transistors in the 
schematicschematic

•• Copy to an array is  an efficient way to create Copy to an array is  an efficient way to create 
many transistorsmany transistors

–– Each transistor should not be wider then Each transistor should not be wider then 
10 10 µµm (15 m (15 µµm)m)

–– Share source and drain regions if possibleShare source and drain regions if possible
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Student Chip ExampleStudent Chip Example

The 20 The 20 µµm wide transistor will cause sparse layoutm wide transistor will cause sparse layout
Poly Poly resistivityresistivity is is typtyp, 11 , 11 ΩΩ/square => 600 /square => 600 ΩΩ to the far end of the gateto the far end of the gate
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Driver ExampleDriver Example

Narrower transistors will result in denser layoutNarrower transistors will result in denser layout
Use the same finger size for different transistors Use the same finger size for different transistors 
and you will very often be a able to share and you will very often be a able to share 
drain/source contactsdrain/source contacts
Substrate contacts are you friends! Use them!Substrate contacts are you friends! Use them!
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Student Chip Example2Student Chip Example2

This layout is not even close to dense!This layout is not even close to dense!
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Size of the left NAND gate: 200 Size of the left NAND gate: 200 µµmm22

Size of right NAND gate: 60 Size of right NAND gate: 60 µµmm22

NAND Gate ExampleNAND Gate Example
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Current DensityCurrent Density
Too high current density will cause Too high current density will cause 
electromigration electromigration (transport of metal ions)(transport of metal ions)
Keep RMS current below 0.6 Keep RMS current below 0.6 mAmA to to 
1 1 mAmA per per µµm interconnect widthm interconnect width
Peak current should be below 30 Peak current should be below 30 mAmA
Metal wires > 30 Metal wires > 30 µµm have to be slottedm have to be slotted
There are FOUR metal layers There are FOUR metal layers –– use all of use all of 
themthem
–– Gate Poly:Gate Poly: 1111ΩΩ/sq/sq
–– Metal1Metal1--3:3: 70 m70 mΩΩ/sq (typ), 120 m/sq (typ), 120 mΩΩ/sq (max)/sq (max)
–– Metal4:Metal4: 440 m0 mΩΩ/sq (typ), 100 m/sq (typ), 100 mΩΩ/sq (max)/sq (max)
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Metal SlotsMetal Slots
Large areas of metal can cause layer separation around Large areas of metal can cause layer separation around 
stressstress--sensitive die corners (stresssensitive die corners (stress--levels “frozen” into die levels “frozen” into die 
during manufacturing)during manufacturing)
Solution:Solution: Introduce slots along direction of current flow in Introduce slots along direction of current flow in 
wide metalswide metals
AMS 0.35AMS 0.35µµm slot rules:m slot rules:

10Min. spacing for 
parallel slots

S1

10Min. spacing for 
slots in sequence

S2

300Max. slot lenghtL2
30Min. slot lengthL1
3Fixed slot widthW1

35Max. METALx width 
without slots

W0
Value [Value [µµm]m]DescriptionDescriptionRuleRule

W0

W1

L1, L2

S1

S2METALx
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Contact ResistanceContact Resistance

Contact resistancesContact resistances
–– Met1 Met1 –– NdiffNdiff: : typtyp. 30 . 30 ΩΩ max 100 max 100 ΩΩ
–– Met1 Met1 –– PdiffPdiff: : typtyp. 60 . 60 ΩΩ max 150 max 150 ΩΩ
–– Met1 Met1 –– Poly: Poly: typtyp. 2 . 2 ΩΩ max 10 max 10 ΩΩ
Via resistanceVia resistance
–– TypTyp 1.2 1.2 ΩΩ max 3 max 3 ΩΩ
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Via Current DensityVia Current Density

If you increase metal wire width to keep current density If you increase metal wire width to keep current density 
low. Think about current density in low. Think about current density in viasvias
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Via Current DensityVia Current Density

Adding extra Adding extra viasvias will not cost you anything extra!will not cost you anything extra!
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Bond PadsBond Pads
Are used to connect your chip to the outside worldAre used to connect your chip to the outside world
Critical part of the chip assemblyCritical part of the chip assembly
The type of PAD depends on the signalThe type of PAD depends on the signal
The The PADsPADs are usually provided by the chip vendorare usually provided by the chip vendor
In the lab library there is a few In the lab library there is a few PADsPADs specifiedspecified

CHIP

~ 80-90µm

Bond wire 

Ø ~ 30µm
Package or 
PCB

1-2mm
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PADsPADs Included in Lab LibraryIncluded in Lab Library

APRIOPAPRIOP
–– Analog Input/Output PADAnalog Input/Output PAD
–– ESD protection includedESD protection included
–– Signal accessed in metal 2 on Signal accessed in metal 2 on 

corecore--side of the PADside of the PAD
–– Padcap Padcap ~1.2pF~1.2pF
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PADsPADs Included in Lab LibraryIncluded in Lab Library

AUPRIOP (not yet available)AUPRIOP (not yet available)
–– Analog Input/Output PADAnalog Input/Output PAD
–– No ESD protectionNo ESD protection
–– Signal accessed in metal 2 on Signal accessed in metal 2 on 

corecore--side of the PADside of the PAD
–– Suitable for highSuitable for high--speed I/O and speed I/O and 

power supply with different power supply with different 
voltage than corevoltage than core
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PADsPADs Included in Lab LibraryIncluded in Lab Library

APRIOWPAPRIOWP
–– Analog Input/Output PADAnalog Input/Output PAD
–– ESD protection includedESD protection included
–– Signal accessed in metal 2 on Signal accessed in metal 2 on 

corecore--side of the PADside of the PAD
–– Wide metal 2 from PAD to Wide metal 2 from PAD to 

corecore
–– Padcap Padcap ~5pF~5pF
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PADsPADs Included in Lab LibraryIncluded in Lab Library

CLK_BUFFCLK_BUFF
–– Clock input PADClock input PAD
–– Include ESD and buffersInclude ESD and buffers
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PADsPADs Included in Lab LibraryIncluded in Lab Library

INPUTPADINPUTPAD
–– Slow input signal PADSlow input signal PAD
–– Includes a small driverIncludes a small driver
–– ESD protection also includedESD protection also included
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PADsPADs Included in Lab LibraryIncluded in Lab Library

OUTPUTPADOUTPUTPAD
–– Slow output signal PADSlow output signal PAD
–– Includes a driver with 8mA Includes a driver with 8mA 

current drive strengthcurrent drive strength
–– ESD protection includedESD protection included
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PADsPADs Included in Lab LibraryIncluded in Lab Library

VDDGNDCORNERVDDGNDCORNER
–– Default power supply Default power supply 

PAD for this coursePAD for this course
–– Provides supply voltage Provides supply voltage 

and ground to the PAD and ground to the PAD 
ring and the Corering and the Core

–– VDD and GND will be VDD and GND will be 
accessed onaccessed on--chip from chip from 
the PADthe PAD--ring

VDD

GND

ring
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PADsPADs Included in Lab LibraryIncluded in Lab Library

CORNERFILLCORNERFILL
–– Fill cell that should be Fill cell that should be 

placed under the placed under the 
VDDGNDCORNER padVDDGNDCORNER pad

–– Increases fill rate in Increases fill rate in 
POLY1POLY1
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PADsPADs Included in Lab LibraryIncluded in Lab Library

VDDPADVDDPAD
–– Separate power supply PADSeparate power supply PAD
–– Includes ESD protectionIncludes ESD protection
–– Supply to PAD ring and coreSupply to PAD ring and core
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PADsPADs Included in Lab LibraryIncluded in Lab Library

GNDPADGNDPAD
–– Separate ground PADSeparate ground PAD
–– Includes ESD protectionIncludes ESD protection
–– Ground PAD ring and coreGround PAD ring and core
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How to Build the PAD RingHow to Build the PAD Ring

Maximum amount of Maximum amount of PADsPADs is 17is 17
The 2 The 2 PADsPADs in the corner are fixedin the corner are fixed
15 15 PADsPADs remains for the students to remains for the students to 
place “freely”place “freely”
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How to Build the PAD RingHow to Build the PAD Ring

A generic PCB will be A generic PCB will be 
built for the built for the 
measurementsmeasurements
Requires that the PAD Requires that the PAD 
placement are placement are 
somewhat restrictedsomewhat restricted

VDDCORE

VSSCORE 
(GND)

High-Speed I/O (50 Ω)

Could also be used as 
power supply.

High-Speed I/O (50 Ω)

2 differential 

4 single-ended

Bias voltage/currents

Additional VDD / VSS

Low-speed I/O

70
0µ

m

800µm
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OnOn--Chip DecouplingChip Decoupling
Every switching draws a current from the Every switching draws a current from the 
power supplypower supply
When many devices switch When many devices switch 
simultaneously, for example at the clock simultaneously, for example at the clock 
edges, huge current spikes might be edges, huge current spikes might be 
introducedintroduced
This gives voltage fluctuations onThis gives voltage fluctuations on--chip chip 
that can cause YOUR chip to malfunctionthat can cause YOUR chip to malfunction
To filter out these high frequency To filter out these high frequency 
components on the power supply a large components on the power supply a large 
capacitance between VDD and GND is capacitance between VDD and GND is 
usedused
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OnOn--Chip DecouplingChip Decoupling
Capacitors for decoupling:Capacitors for decoupling:
–– PolyPoly--poly capacitor, poly capacitor, cpolycpoly ~0.8fF/um~0.8fF/um22

–– GateGate--cap, use a transistor as a decoupling cap, use a transistor as a decoupling 
capacitor. Example: NMOS with the gate capacitor. Example: NMOS with the gate 
connected to VDD and Drain&Source groundedconnected to VDD and Drain&Source grounded

–– GateGate--cap gives more capacitance per area, cap gives more capacitance per area, 
~4.5fF/um~4.5fF/um22

Use decoupling for all DCUse decoupling for all DC--voltagesvoltages
How much decoupling is needed?How much decoupling is needed?
–– Depends on the switching activityDepends on the switching activity
–– Depends on how sensitive your design is to power Depends on how sensitive your design is to power 

supply fluctuationssupply fluctuations
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Common Layout MistakesCommon Layout Mistakes
Too small decoupling capacitor!Too small decoupling capacitor!

ONE is NOT enough!ONE is NOT enough!
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How to Connect Your Design How to Connect Your Design 
to the to the PadframePadframe

Digital input/output pads have internal buffers. Digital input/output pads have internal buffers. 
YOU have to make sure these buffers are YOU have to make sure these buffers are 
powerful enough for your designpowerful enough for your design
Do you need a driver in order to drive the driver Do you need a driver in order to drive the driver 
included in the I/O pad? included in the I/O pad? 
You can also design your own pad driver and use You can also design your own pad driver and use 
an analog padan analog pad
If you have an external clock, make sure to use If you have an external clock, make sure to use 
an appropriate clock bufferan appropriate clock buffer
Analog inputs/outputs should use the analog Analog inputs/outputs should use the analog 
pads without bufferspads without buffers
Use VDD/GND pads for VDD and GNDUse VDD/GND pads for VDD and GND
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Available Components from PRIMLIBAvailable Components from PRIMLIB

3.3V NMOS/PMOS3.3V NMOS/PMOS
5V NMOS/PMOS5V NMOS/PMOS
Poly1Poly1--Poly2 capacitors (Poly2 capacitors (cpolycpoly))
HighHigh--resistive poly resistor (resistive poly resistor (rpolyhrpolyh))
LowLow--resistive poly resistor (rpoly1 and resistive poly resistor (rpoly1 and 
rpoly2)rpoly2)
NwellNwell resistor (resistor (rnwellrnwell))
There are other components as well in There are other components as well in 
PRIMLIB that can be used. Discuss with PRIMLIB that can be used. Discuss with 
your supervisor before using them!your supervisor before using them!
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Antenna ErrorsAntenna Errors
Antenna errors occur when a large metal Antenna errors occur when a large metal 
structure is connected to a gate. When the metal structure is connected to a gate. When the metal 
is etched in the fabrication a large amount of is etched in the fabrication a large amount of 
charged might be induced in the metal. This can charged might be induced in the metal. This can 
cause the gate to break if there is no discharging cause the gate to break if there is no discharging 
path for high voltages (like a drain/source or a path for high voltages (like a drain/source or a 
reversed diode)reversed diode)
Antenna errors can be fixed by adding a reversed Antenna errors can be fixed by adding a reversed 
diode connected to the metal wire causing the diode connected to the metal wire causing the 
problem. An N+ doped problem. An N+ doped nwellnwell contact will function contact will function 
as a reversed diode if connected to the substrate. as a reversed diode if connected to the substrate. 
Another way to solve antenna errors is to build a Another way to solve antenna errors is to build a 
bridge in higher or lower layers, and thereby bridge in higher or lower layers, and thereby 
break the long metal wire connected to the gate break the long metal wire connected to the gate 
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Antenna ErrorsAntenna Errors

P-substrate 
N+ N+ 

N+ 

Poly gate 

M1 wire 

P-substrate 
N+ N+ 

Poly gate 

M1 wire 

M2 bridge

Long metal wire with reversed diode to substrate. 

Long metal wire broken up by a bridge in higher or lower layers 

M1 wire 
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How to Organize the TOPHow to Organize the TOP--LEVEL LayoutLEVEL Layout
Your TopYour Top--Level layout should consist of Level layout should consist of 
the following instances:the following instances:
–– Pad framePad frame
–– The core of your designThe core of your design
–– FillpatternFillpattern (up to Met3)(up to Met3)
–– TopmetTopmet fillfill
–– FIMP and NLDDFIMP and NLDD

Fill can be created by using scriptsFill can be created by using scripts
To avoid fill at certain places, add a To avoid fill at certain places, add a 
blocking layerblocking layer
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How to Organize the TOPHow to Organize the TOP--LEVEL LayoutLEVEL Layout

At the top levelAt the top level
–– Always make sure all the instances have Always make sure all the instances have 

the same origin, preferably (0,0)the same origin, preferably (0,0)
–– If you accidentally move one cell you can If you accidentally move one cell you can 

easily put it back on the right placeeasily put it back on the right place
Use the command “Edit in Place” if Use the command “Edit in Place” if 
necessary, but be careful. Make sure you necessary, but be careful. Make sure you 
are doing your changes in the correct cellare doing your changes in the correct cell
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Common Layout MistakesCommon Layout Mistakes
Build dense layouts instead of like this one! Build dense layouts instead of like this one! 
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Common Layout MistakesCommon Layout Mistakes
Dense layouts to reduce the  length of wires!Dense layouts to reduce the  length of wires!
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Common Layout MistakesCommon Layout Mistakes
Power grid!Power grid!

GND wire
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Chip Verification Flow (1)Chip Verification Flow (1)
1.1. DIVA DRC and LVS of local cellsDIVA DRC and LVS of local cells
2.2. DIVA DRC and LVS of complex cellsDIVA DRC and LVS of complex cells
3.3. ASSURA DRC and LVS of padframeASSURA DRC and LVS of padframe
4.4. ASSURA DRC and LVS of chip topcellASSURA DRC and LVS of chip topcell

(chip core, padframe, decoupling capacitors) (chip core, padframe, decoupling capacitors) 
Take care of Antenna errorsTake care of Antenna errors

5.5. Simulate chip topcell Simulate chip topcell 
(only extracted capacitances)(only extracted capacitances)

6.6. Stream out a GDSII fileStream out a GDSII file
7.7. Stream in the GDSII file to a NEW libraryStream in the GDSII file to a NEW library
8.8. LVS of streamed in chip top cellLVS of streamed in chip top cell

(compare streamed in layout and original (compare streamed in layout and original 
schematic)schematic)
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Chip Verification Flow (2)Chip Verification Flow (2)
9.9. Generate Metal Fill Generate Metal Fill 

to avoid overto avoid over-- and under etchingand under etching

10.10. Generate FIMP (Field Implant) layer Generate FIMP (Field Implant) layer 
to avoid weak parasitic transistors under poly interconnectsto avoid weak parasitic transistors under poly interconnects

11.11. Generate NLDD (N Lightly Doped Drain) layerGenerate NLDD (N Lightly Doped Drain) layer
for transistor channel engineering purposesfor transistor channel engineering purposes

12.12. ASSURA DRC and LVS of chip topcellASSURA DRC and LVS of chip topcell
(chip core, padframe, decoupling capacitors, (chip core, padframe, decoupling capacitors, 
Metal Fill, FIMP, NLDD) Metal Fill, FIMP, NLDD) 

13.13. Stream out a GDSII fileStream out a GDSII file
14.14. Stream in the GDSII file to a NEW libraryStream in the GDSII file to a NEW library
15.15. LVS of streamed in chip top cellLVS of streamed in chip top cell

(compare streamed in layout and original (compare streamed in layout and original 
schematic)schematic)
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StreamStream--In to NEW library!In to NEW library!
Use Use 
File>New>Library File>New>Library 

to create a NEW streamto create a NEW stream--in library! in library! 
This automatically sets library pointers correctlyThis automatically sets library pointers correctly

Example mistake:Example mistake:

Edit > Library Path…Edit > Library Path…

Entered new streamEntered new stream--in in 
library name with library name with 
pointer to original pointer to original 
design library!!design library!!

OVERWROTE THE OVERWROTE THE 
COMPLETE DESIGN!

Two libraries... ...with identical 
pointers!!

COMPLETE DESIGN!
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